Chapter 2

The Fractal Coastline and
Dimension

ATOMS AND MOLECULES MOVE RANDOMLY. Gas molecules rush
around in all directions with different speeds, zigzag, turn, reverse di-
rection. Disordered. Random. Unpredictable.

Sometimes molecules combine to form uneven structures: branching
trees, scraggly nerve cells, patchy forests, jagged coastlines. Ragged.
Unpredictable.

Other times molecules combine to form structures that are ordered
and even: crystals, snowflakes, seashells. Orderly. Symmetric. Pre-
dictable.

Q2.1: Can you think of patterns in nature?
Which can be described as ordered? Which
can be described as disordered?

What is science good for? For description! To tell us what is hap-
pening. To describe the randomness in nature. For prediction! To tell
us what is going to happen. To predict the order that often grows from
randomness.

This book describes how probability and chance often shape struc-
tures around us: coastlines, nerve cells, termite tunnels, bacterial
colonies, forests, root systems, river deltas, rough surfaces. These struc-
tures and processes may seem hopelessly unpredictable, but every single
one has a design or behavior that can be described using the idea of
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a natural fractal. Natural fractal is a powerful idea used every day in
scientific research. Every natural fractal is different from every other.
No one has ever seen the patterns you will grow in the laboratory and
by computer, because each pattern is unique. You will use fractals to
investigate the dividing line between the known and the unknown.

The following exercise illustrates a strange property of a coastline:
The measured length of a coastline depends on the length of the ruler
you use. We will find that this and similar properties describe natural
fractals.

2.1 Coastline

How is measuring the length of a coastline different from measuring the
circumference of a circle or the distance around a square? For example:
How long is the coastline along an ocean shore? Is its length equal to
the mileage reading on the odometer of an automobile driving along the
straight road beside the beach? Is it the distance covered by a bicyclist
who pedals along the shore on a footpath? Is it the length run by a
jogger whose morning exercise includes running “next to the water?”
Is it the number of steps of a little bird running along the edge of the
water looking for washed-up morsels? Whose “length of coastline” is
the true one?

Trying to answer these innocent questions leads to deeper questions
and our first look at natural fractals.

Table 2.1: Measuring the length of a coastline.

Number of Steps, N | Number of Steps, N

1. Size of step, S 2. PREDICTED 3. MEASURED 4. “Length” = N x S

X X X X X
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Figure 2.1: Measuring a coastline with caliper. The caliper often “steps
across” a peninsula or inlet.

HandsOn 1: “Walking” Along a Coastline

To investigate coastlines, start by “walking” along the map of a coast-
line as shown in Figure 2.1.
You will need:

e a map of the coastline to be measured and

e a pair of calipers, i.e., dividers (a caliper or divider is like a circle-
drawing compass, except that both ends have points)

1. Make decisions about:
A. the points on the map between which to measure the length

of coastline

B. the scaled distance on the map for the first setting between
the ends of the calipers (preferably a multiple of two, such
as 64 kilometers or 32 miles).
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. Separate the points of the calipers by the scaled distance of step
1B. Place the first end of the calipers at the beginning of the
coastline to be measured and swing your calipers so that the
second end rests on the coastline as close to the starting point
as possible. This is your first step along the coastline.

. Now swing the caliper so that the first end “walks” along to the
nearest next point on the coastline. This is your second step.

. Continue this process, counting the steps as you go; stop when
your next step would carry you beyond the end of the coastline.
The total number of steps multiplied by the distance covered in
each step gives an initial measurement of the length of your coast-
line. For example: 10 steps, each of a length of 64 kilometers,
yields a total length of 10 x 64 kilometers = 640 kilometers.

. Enter the size of the step (in miles, kilometers, or whatever) in
the left column of your copy of Table 2.1. Enter the number of
steps in the third column.

. Now you are going to start again, this time reducing the distance
between the calipers to half its original value. Before you do this,
predict the number of steps it will take you to walk along the
coastline with this smaller step size. Enter your prediction in the
second column of your copy of the table.

. “Walk” along the coastline again with the calipers set to half the
original distance. Count the total number of steps and record the
results in the correct columns of your copy of Table 2.1. How
accurate was your predicted number of steps?

. Repeat the process of cutting in half the distance between the
caliper points as many times as you can, each time making a
prediction, taking the walk, and filling in your copy of the table
with your results.

. Fill in the right-hand column of your copy of the table by mul-
tiplying each step size by the number of steps to get a total
“length.”
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Q2.2: Did your prediction of the number of
steps become more accurate with each new set-
ting of the calipers?

Q2.3: What happens to the total length of the
coastline for different step sizes?

Q2.4:  What would you estimate the “final
length” of the coastline would converge to as
the step size gets smaller and smaller?

HandsOn 2: Measuring the Dimension of a Coast-
line

Now you are going to plot on graph paper the data you collected from
your coastline measurements. A blank piece of graph paper for you to
copy is given in Figure 2.2. This is a special kind of graph paper. If you
have not used such graph paper before, the uneven scales may appear
odd.

These scales, called logarithmic, are explained in the section Dimen-
stons and Logarithms at the end of this chapter. Basically, the numbers
2,4,8,16,32,64, ... occur at equal intervals along each axis, as do the
numbers 10, 100, 1000, . .. When logarithmic scales are along both axes,
the graph paper is called log-log paper. For now, you need to know only
one thing about this novel scale: You can add a zero to all the numbers
along either axis and the graph paper is equally useful. For example,
the vertical axis can be relabeled 10, 20, 40, ... 100, 200, 400 ... 1000,
2000, 4000, ... 10,000. The result is perfectly usable providing the
numbers you are dealing with are in the corresponding range. Or you
can multiply all numbers along either axis by 1/10. For example the
vertical axis can be relabeled 0.1, 0.2, 0.4, ... 1, 2, 4, ... 10, 20, 40, ...
100. If the entries in your copy of the table do not match the numbers
on one axis of the graph paper, just multiply all the numbers on that
axis by 10 or by 1/10 until they do match.

END ACTIVITY
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Figure 2.2: Graph paper for plotting the entries in Table 2.1. Do not

draw

on this grid. Photocopy it; you will need several copies. (This

figure is stored in digital format in the accompanying CD-ROM.

1.

Plot the numbers from your table on a copy of the graph paper.
Plot the number of steps along the vertical axis and the step size
along the horizontal axis. What kind of curve do the plotted
points form? Do they lie approximately along a straight line?
When they lie approximately along a straight line on this kind
of graph, it is possible to define the object’s dimension. The
dimension is equal to the magnitude of the slope of this straight
line. For some objects this slope—this dimension—is not a whole
number. Objects with non-integer dimension are called fractals
(meaning they have “fractional” dimensions).

With a ruler, draw by eye the “best” straight line using the points
on your graph. Determine the magnitude of the slope of your
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graph. The slope is defined as

change in vertical rise along the line “rise”

slope = (2.1)

change in horizontal run along the line  “run”

These vertical and horizontal changes are laid out using linear
measures, not logarithmic. Use a regular ruler to measure this
slope, not the scale along the axes as shown in the example of
Figure 2.3.

Q2.5: What is the magnitude of the slope (the
dimension) of your coastline?

Q2.6: Why would a scientist care about the
dimension of objects?

Now, to get a better feel for the process of formation of a coastline
do at least one of the following two HandsOn activities. The first
(HandsOn 3) is a group or classroom activity. The second (HandsOn
4) is an individual activity.

HandsOn 3: Creating a Rope Coastline

In order to study coastlines further, create a sample coastline using the
following instructions. You will need for this activity

e a rope, such as a clothesline, about 30 meters long,
e a single die, and

e 3 coin.

The activity takes place with the class in a wide hall, entrance hall,
or outdoors. Select one class member to roll the die and another to flip
the coin.

END ACTIVITY
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Figure 2.3: Measurement of the slope of a straight line, using the linear
coordinates of a regular ruler. The slope is negative, because for the
positive “run” there is a negative “rise” (see Eq. 2.1).

1. Two class members, Student #1 and Student #2, stand about
20 feet apart as shown in Figure 2.4. Student #1 holds the end
of the rope. Student #2 pulls the rope into a line, keeping the
unused portion of the rope coiled at his or her feet.

2. Select a direction perpendicular to the rope to be the positive
direction. The opposite direction will be the negative direction.

3. Student #3 grasps the rope approximately in the middle.

4. Flip the coin. Heads or tails determines the direction the person
in the middle will move in STEP 5 below.
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. Roll the die. The person in the middle of the rope takes a number

of “baby steps” (steps that touch heel to toe) perpendicular to
the rope. The number of steps is equal to the number on the die:
from one to six. The direction of these steps is determined by
the outcome (heads or tails) of the coin flip performed in step 4.
Student #2 lets the rope slip out to provide the extra length as
needed.

. Now Students #4 and #b5 take up a position in the middle of each

straight segment.

#3

#1 #2

# #5

Figure 2.4: The initial steps of creating a rubber band or rope coastline
as described in HandsOn 3 and 4.

7. Repeat STEPS 4 through 6 for Student #4, who takes the number

of baby steps indicated on the die in a direction perpendicular to
the rope indicated by the coin flip. Do the same for Student #b5.

. Continue this process, randomly deflecting the midpoint perpen-

dicular to each straight segment, until you run out of either rope
or students.

9. Take a photograph of the resulting “coastline.”

HandsOn 4: Creating a Rubber Band Coastline

Construct a coastline using a rubber band. You will need

END ACTIVITY
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e a rubber band,

e a single die, and

e nine or more thumb tacks.

1.

Place a blank sheet of white paper on a bulletin board and over
it stretch the rubber band between two thumb tacks (as shown
in Figure 2.4) a vertical distance 20 centimeters apart. Treat the
doubled rubber band as a single line.

. Locate the midpoint of the rubber band. You are going to move

this midpoint right or left a random amount and hold it there
with a third thumb tack. Here is how:

Roll the die.

— If you get 1, push the midpoint left by 4 centimeters, hold
it with the thumb tack.

— If you get 2, push the midpoint left by 2 centimeters, hold
it with the thumb tack.

— If you get 3, leave the midpoint where it is, but hold it with
a thumb tack.

— If you get 4, push the midpoint right by 2 centimeters, hold
it with the thumb tack.

— If you get 5, push the midpoint right by 4 centimeters, it
with the thumb tack.

— If you get 6, roll again.

Now look at the two segments that make up your coastline. Re-
peat the above process on each of the segments, pushing the mid-
point to one side or the other perpendicular to the direction of the
segment. Pin each relocated midpoint to obtain a four-segment
coastline.

. Repeat one more time on the four segments to get an eight-

segment coastline. Trace the final coastline on the white paper
backing and leave it on the bulletin board.
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Q2.7:  Did the previous two activities teach
you anything about the process of forming nat-
ural fractals? Can you draw parallels between
your own creation of an artificial coastline using
a rope or rubber band and the natural process
that creates real coastlines?

Before we go on to the computer activities, we delve a bit deeper
into the meaning of natural fractals and how they are formed. There
are two types of fractals: non-random (or deterministic) and random
(or natural). You will learn more about non-random or mathematical
fractals in Section 2.3 on page 26.

Coastlines are examples of natural fractals, also called random frac-
tals. Natural fractals are formed through random processes, such as
erosion of a beach to create coastlines. This erosion was modeled by
our coin flipping and die throwing. No two coastlines are ever exactly
the same; neither are two snowflakes or two lightning bolts. Though
two such patterns may have some overall features in common, if you
look closely you will see that they differ in the details of their struc-
ture. The same is true for other natural fractals as well. Each example
is unique, because the chances are almost zero that exactly the same
sequence of random events will occur in the growth of two different
patterns, such as two snowflakes. In the previous exercise, you created
a model of a fractal coastline using a rubber band, thumb tacks, and
a die (or a rope, a die, and a coin). It is unlikely that you and your
classmate would get exactly the same sequence of numbers when you
throw your die, and therefore it is unlikely that your coastlines will be
identical to one another.

The erosion process on a beach is random: the resistance of rocks
along the shore as well as the force of incoming waves at a particular
spot vary more or less randomly. Thus, when the outcome of the toss
of a coin or die tells you to move your “coastline” back one step, you
are mimicking this process, and randomly identifying a “weak spot” on
the shore that gives in to the force of incoming waves.

END ACTIVITY
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Q2.8: Could you have estimated the dimension
of your coastline to be within certain values just
by looking at it? How? Can you think of other
natural fractals with:

(a) dimension between 0 and 1

(b) dimension between 1 and 2

(c) dimension between 2 and 3

Q2.9: Can you say anything about the pro-
cesses that form these fractals?

SimuLab 1: “Walking” Along a Coastline

Now we use a computer program to draw the model of a coastline and
to measure the dimension of that model using the “ruler method” (see
Figure 2.5).

1.

Open the program Coastline. Click on the title panel to start
the program. An initial straight vertical coastline separates the
green land on the left from the blue water on the right.

Click on the Step-by-step button, so that you can watch the
construction of the coastline.

Click on the Draw button once. What rule do you think the
computer uses to start the coastline?

Click on the Draw button a second time. What does the com-
puter do?

. Go on clicking the Draw button (you can do this up to 10 times).

Make additional coastlines by selecting New under the File
menu. You can speed up the drawing by clicking on the Au-
tomatic button.
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Figure 2.5: Screen display in the Coastline program.

7. Make several different coastlines. Each time change the Rough-
ness setting by clicking on the control boxes containing the sym-
bols <, <, >, or >. Does every roughness setting give you a
realistic coastline?

8. Find a roughness setting that gives you a coastline about as jagged
as the actual coastline you measured before (even though the
overall shape may not be the same). Give this coastline a name
using the Save as ... command in the File menu.

9. Now measure the dimension of your constructed coastline. Go
to the Measure menu. There are two options, one using a ruler
(calipers) and one using the grid. Choose Using Ruler, set the
ruler length with the size bar to a rather large value, then select
Manual Measure from the panel at the right side of the screen.



END ACTIVITY
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One end of the ruler is anchored at one end of the coastline and
the other end points toward the cursor. Move the cursor to set
the free end of the ruler at a point on the coastline and click the
mouse to anchor it, which creates a new ruler.

Repeat the process until you have stepped along the whole coast-
line. When you reach the bottom, press the Done button. If you
make a mistake, press the Cancel button to start over.

Change the ruler length, and this time click on the Auto Mea-
sure button. Then the computer will do the “stepping” for you.

Repeat the process with several different ruler lengths. Each re-
sult is automatically entered into the data table.

Now let the computer analyze the data. Press the Done Mea-
suring button. Explore for yourself the Table and Graph com-
mands under the Data menu. This shows the data you have
collected and different ways to graph it, similar to what you did
by hand in previous activities.

The kind of graph we drew in HandsOn 1 to measure dimension
is called a log-log graph. (See Section 2.4 on page 29 for an
explanation of the log-log graph.) Under Graph Type choose
y vs. x (log-log scale). The size L of the ruler is plotted along
the horizontal axis, and the number N of ruler lengths to follow
the coastline along the vertical axis. Click on the Curve Fit
button to draw the best-fit straight line through the points. The
slope is the dimension of the coastline, which appears as the
exponent in an equation next to the graph. Write down the value
of this dimension; you will need it later. Does this dimension
have a value approximately equal to the dimension of the map
coastline you measured in HandsOn 17

Give this coastline a name you can remember using the Save
as... command in the File menu.



2.1.

COASTLINE 19

HandsOn 5: Covering a Coastline with Boxes

Thus far we have used the ruler method for measuring the dimension
of a coastline. An alternative method is called the grid method or box
method or covering method. The grid method is a bit more versatile
than the ruler method, and can be used for different kinds of fractals.
Here is how it works:

1.

2.

Get out the map whose coastline you measured originally.

Take a second piece of blank paper approximately the same size
and cut out a square that just covers the entire coastline to be
measured. Call the edge-length of this square L = 16.

Now fold the covering square into fourths and cut along the fold-
lines. Each of the four squares has an edge length L = 8.

. Predict: How many of these L = 8 squares will it take to cover

the coastline? The word “cover” means “cover up”: the squares
lie along the coastline without overlapping, but so that no piece
of the coastline is visible. Enter your prediction in a copy of Table
2.2.

Now cover the coastline with L = 8 squares and enter the result
in your copy of the table. How good was your prediction?

Fold each of the smaller covering squares into equal fourths and
cut along the fold lines. Predict how many of these squares of
length L = 4 it will take to cover the coastline. Enter your
prediction in your copy of Table 2.2.

Now cover the coastline with squares of L = 4 and enter the result
in your copy of Table 2.2.

Repeat this process with squares of edge-length 2, and 1. In each
case predict the number of squares that will be needed to cover
the coastline, and enter the result in your copy of the table before
measuring and entering the actual number of squares needed to
cover the coastline. Were your predictions closer to your measured
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values this time than when you predicted results for the ruler
method?

10. Get out your original log-log graph of the coastline results. Plot
the data from your copy of Table 2.2 on the same graph. This time
the vertical scale will be “number of squares to cover coastline”
and the horizontal scale will be “edge length of square.” Is the
result approximately a straight line? If so, is the slope of the line
the same as you found using the ruler method?

Table 2.2: Covering the Coastline with Boxes (used in HandsOn 5 and

SimuLab 2)
Edge length of PREDICT: MEASURE:
Square Number of Squares to cover | Number of Squares to cover
Coastline Coastline

16
8
4
2
1

QQ2.10:  Based on your use of the ruler and
grid methods, which do you find more efficient?
Does it make sense to ask which method is more
“accurate”? Explain.

SimuLab 2: Covering a Coastline

Now let the computer help you carry out the grid method quickly and
easily.

1. Call up the Coastline program again.

2. From the File menu, select Open and call up the coastline you
saved earlier.
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Under the Measure menu, choose Using Grid. The size control
allows you to adjust the size of the grid.

. Click on the Manual Measure button, as you did previously.

Click on every grid square in which any part (even a very small
piece) of the coastline shows. When you are done, the resulting
set of grid squares should completely cover the coastline. Click
on Done.

. Try another grid size. This time click on Auto Measure and let

the computer cover the coastline. Each result will be entered into
the data table automatically.

Let the computer cover the coastline with grids of a variety of
sizes. When you have used as many grids as you want, click on
Done Measuring.

Now have the computer analyze the data using a log-log plot to
find the dimension of your coastline according to the grid method.

. Compare the value of the dimension measured using the grid

method with the value of the dimension you obtained earlier using
the ruler method.

Using Save in the File menu, save your coastline under a new
name. You will need this file later.

Summarize this part of the project by entering values of dimension
for both coastlines in a copy of Table 2.3.

Table 2.3: Measured Dimensions of Coastline

Measurement method Dimension Dimension

of actual coastline | of computer coastline

Ruler/Caliper

Grid/Box

END ACTIVITY
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2.2 Dimension of “Non-Fractals”

We have been measuring the non-integer dimension of coastlines. The
shape of a coastline is called a fractal. Non-fractal objects have integer
dimensions. For example, a line is 1-dimensional. A non-crumpled
piece of paper is 2-dimensional. A cube is 3-dimensional, as shown in
Figure 2.6.

HandsOn 6: 1-, 2-, and 3-Dimensions

Fill in a copy of Table 2.4. Now plot the entries in this table on a fresh
copy of the log-log graph paper. Along the horizontal axis plot the
number of segments and, on the vertical axis, the entries in columns 2,
3, and 4. Draw a line through each set of points and verify that a line,
square, and cube are 1-, 2-, and 3-dimensional, respectively.

Table 2.4: Verifying dimensions of a line, a square, and a cube.

END ACTIVITY

¢ | Number of segments | Number of squares | Number of cubes
of length d needed of side d needed of edge d needed
to span line to cover square to fill cube
of length L = 100 | of area L? = 10,000 | of volume L3 = 10°
1
2
5
10
20
50
100

Note that in Figure 2.6 the dimension is the exponent in the equa-
tion for length or area or volume, as a function of L.

HandsOn 7: Circle Measurement of Dimension

One method we have been using to measure fractal dimension is the
method of covering. There are other methods for measuring dimension.
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L
L
L
L L
L
Length = Lt Area= L2 Volume = L3
1-dimensional 2-dimensional 3-dimensional

Figure 2.6: Examples of objects with 1, 2, and 3 dimensions.

One that is useful for objects with dimension less than or equal to two
involves measuring the total area of the object present inside circles of
different radii. For a surface in a plane, the area increases as the square
of the radius: A = mR?. The power 2 of R tells us—again!—that a disk
is 2-dimensional.

Check results of the formula A = 7R? by counting the number of
cells inside circles of different radii in Figure 2.7. For each circle, count
all the cells inside that circle, not just those between that circle and
the next smaller circle. Enter your results in a copy of Table 2.5.

Table 2.5: For use with Figure 2.7.
r (radius) N (count)

0.5
1.5
3.5
7.5
15.5

Plot the results from your copy of Table 2.5 on a log-log graph, the
radius scale along the horizontal axis and N along the vertical axis.
From the measurement of the slope, calculate the dimension of the
circular surface in Figure 2.7.
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Figure 2.7: Count the cells inside each circle to discover that the surface
of the figure is 2-dimensional.

Now measure the dimension of the line in Figure 2.8 using a similar
procedure. First, count the number N of short line segments inside
each circle of radius r. Enter the results in a copy of Table 2.6. Second,
plot N versus r on a log-log graph and measure the slope. What is the
value of the dimension of the line?

Q2.11:  Suppose the line in Figure 2.8 were
not not straight, but curved. What dimension
would it have, according to the circle method?
Cut a piece of string to the length of the line
in Figure 2.8, lay it down curved on Figure
2.8 and check its dimension with the circle
method.
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Figure 2.8: Count the number of line segments inside each circle to
discover again that a line is 1-dimensional.

Q2.12:  What is the dimension of this pat-
tern? Is this a fractal? What would be the
best method for calculating its dimension ?

END ACTIVITY
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Table 2.6: For use with Figure 2.8.
r (radius) N (count)

O &= | DN

16

2.3 Mathematical Fractals

We learned previously that there are two types of fractals: natural
and mathematical. Unlike a natural fractal, a mathematical fractal is
constructed according to a set of fixed rules which do not involve any
random processes. Given the fixed rules, the resulting structures are
always identical to one another.

Now we create a coastline that is a mathematical fractal, using a
different set of rules—rules that have no randomness. You won’t be
needing any dice to throw or coins to flip. Since the rules have no
randomness, this time you and your classmates should get the identical
result.

HandsOn 8: Creating Your Own Mathematical
Fractal

The mathematical fractal coastline we are about to create is called the
“Koch curve.” You will need:

e a piece of elastic or a rubber band,
e a ruler, and

e 3 handful of thumb tacks.

In this procedure, we follow the same rule over and over. The central
third of a rubber band segment gets turned into a V, like this:
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Figure 2.9: Beginning the construction of the mathematical fractal
called the Koch curve.

1. On a bulletin board, stretch a piece of elastic or a rubber band
between two thumb tacks a distance 9 centimeters apart (Figure
2.9). What is the initial length of your straight “coastline?” If
this were a map, a giant could span the entire coast in one step.

2. Place thumb tacks into the elastic 3 centimeters from each end,
so that it is divided into 3 equal segments.

3. Take the midpoint of the middle part and pull it perpendicular
to the original line to form a V, with each side of the V being 3
centimeters long. Insert a thumb tack to hold it in place. How
many segments does your coastline have now — that is, how many
straight-line steps does it take to walk exactly along the coastline?
What is its total length now? Complete the second row of your
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copy of Table 2.7.

. There are now four segments, each 3 centimeters long. In each

segment, place two thumb tacks so that the segment will be di-
vided into three 1-centimeter parts; then turn the middle part of
each segment into a V by pulling it perpendicular to the line and
inserting a thumb tack. Each side of each V should be 1 cm. long.
How many straight-line steps does it take now to follow the coast-
line exactly? What is its total length? Add this information to
your copy of Table 2.7.

. Now think what the result of the next stage will be. How long will

each segment (step) be? How many steps to follow the coastline
exactly? What is the total length? Add this information to the
copy of Table 2.7.

. Complete the final row of your copy of Table 2.7 by looking at

the pattern of other entries.

Table 2.7: Properties of a Koch Curve.

Length of each step | Number of steps to follow coastline | Total length

(cm.) exactly (cm.)
9 1 9
3 4

Q2.13: Imagine carrying out the process of
turning the middle third of each segment into a
V again and again an infinite number of times.
How would the curve look? How long would
each step be? How many steps would it take to
follow the coastline exactly? And what would
be the total length of the coastline?
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Q2.14: How does this mathematical fractal
differ in appearance from the random fractal
coastlines you created in the exercises above?

Plot the table entries on a copy of the log-log graph paper of Figure
2.2. (Note: Recall that you can multiply all entries on both axes by
10 or 1/10 to accommodate the range of numbers to be plotted.) The
length of each segment is plotted along the horizontal axis and the
number of steps along the vertical axis. Is the result a straight line? If
so, what is the slope of this line? The accepted value of the dimension
of a Koch curve is 1.26. How does the magnitude of your measured
slope compare with this number?

2.4 Dimensions and Logarithms (Ad-
vanced)

Let’s derive the equations that justify the measurement of the dimen-
sion of an object as the magnitude of the slope of a straight line on a
log-log graph. Think of a pattern that has a fixed area and fixed overall
width L. We are going to cover this pattern with square boxes of width
d and count the number N of the boxes needed to cover it. For a solid
area, we have a dimension of 2 and the general formula

(Area) = (Constant) L?.

The constant depends on the shape. As examples, Figure 2.10 shows
shapes with three different values of this constant.

Now we cover any of these shapes with little boxes of width d and
area d’>. How many boxes N does it take? The following formula is
approximately correct:

(Area) = Nd*> = (Const)L? = (Const) (Lg)Q = (Const) <§>2 d?,

or
2

Nd® = (Const) (3) &.

END ACTIVITY
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Figure 2.10: The area of three 2-dimensional figures, showing three
values of the constant in the area formula (Area) = (Constant)L?.

Cancel the factor d? on both sides of the equation to obtain:

L 2
N = (Const) (5) — d"2 x [(Const) x L7,
This result is for a 2-dimensional object, such as those shown in
Figure 2.10. For a fractal, the dimension is not necessarily 2. Call the
dimension D. Then the corresponding equation becomes:

N =d P x [(Const) x L”].
Now take the logarithm (log) of both sides:
log N = log(d ™) 4 log[(Const) x L”].

Here L is fixed; we are not changing the area or the overall width L of
the figure as we use boxes of different width d to cover it. Therefore ev-
erything in the square bracket is a constant, and the log of the quantity
in the square bracket is also a constant, which we can call “Constant”
Using the property of logs, we have:

log N = —Dlogd + Constant.

Think of the variables as log N and logd rather than N and d. Then
this can be thought of as the equation of a straight line with slope —D.
Hence our log-log boz-covering plot will yield a straight line whose slope
is the negative of the dimension D.
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Take care when measuring the slope D to not use the numbers along
the logarithmic scales. Instead, measure this slope directly, that is, with
an ordinary ruler, as shown in Figure 2.3, or use the formula:

log Ny — log Ny
logdy, —logd;

slope =

2.5 What Do You Think?

Q2.15: What does it mean to you that an object has a
fractional dimension? (HINT: The following questions could
prompt their thinking: How does the object fill space? Is
its use of space dense or sparse? Are its edges smooth or
jagged? What is similiar throughout different parts of the
object? What is random or different throughout different
parts of the object? How does the whole object compare
with individual parts of the object? What geometric shapes
do you see in the object: circles, lines, ovals, spheres?)

(Q2.16: Is there a quantitative difference between measuring
the coastline by the “ruler method”, “box method”, and
“circle method”? If so, can you explain why? Why would
scientists need all three methods (i.e., why don’t they just
pick the “best one”)? HINT: Think of some examples from
nature which would be better suited towards a particular
method.

Q2.17: In the beginning of Section 1.1 we talked about the
length of the coastline as measured by various observers
(e.g., an automobile, bicyclist, jogger and bird). Can you
say whether the fractal dimension of the coastline measured
by these observers would be the same or different? How
does it change (or not change)? Which observer would get
the most accurate fractal dimension?




Research
projects
can be pub-
lished on our
Web site.
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Research Projects

We encourage you to pursue independent research projects. Science
moves forward through research! Try one of the suggestions below
or design your own. Or, feel free to write an essay using any of the
questions throughout this chapter as inspiration.

e Working With Coastlines. Obtain a printed map of your fa-
vorite coastline (a good source is www.mapquest . com on the Web).
Using calipers or a pencil compass “walk” along the coastline with
different step sizes. Construct a table similar to that produced
in the Coastline program. Determine the fractal dimension by
hand and using the computer program. Write a report which
discusses the role of multiple measurements and a comparison of
your hand measurements to the computer measurements.

e Formation of Natural Fractals. As a variation, trace the
evolution in time of the fractal dimension of a natural fractal such
as a coastline as it is formed. You are asking the question: what
is the fractal dimension after each step in the creation process?
Does this change in dimension in terms of the natural process of
erosion.



